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INTRODUCTION TO POLAR CARDIO GX
Welcome to Polar Cardio GX! Polar Cardio GX is a Polar solution for group exercise at fitness and health
clubs. Cardio GX enables arranging heart rate-based training sessions, in which the heart rates of the exercisers are displayed on a screen. Polar Cardio GX is suitable for different kinds of indoor group exercise sports
when a computer and a screen are available.

THE POLAR CARDIO GX SYSTEM
The Polar Cardio GX system consists of a PC software, a base station, transmitters (strap and connector)
and a charger. Find out more about the hardware in the hardware section of this help. The Cardio GX system
can be set up with either one or two compatible PCs.
The PC software consists of two parts:
l

Reception tool for managing sessions, session types and exercisers, storing training data, setting up
the hardware, and signing up for sessions.

l

Session tool for heart rate monitoring during the session and summarizing the individual heart rate data
after the session.
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Reception tool and session tool can be installed onto same or separate computers depending on your
Cardio GX system setup.
We recommend that you read through this software help before beginning to use the Polar Cardio GX system.
It is the easiest way to learn how to utilize the system at your club.
We also recommend that you install all the software updates available to get the newest software features
and user guidance.

SYSTEM REQUIREMENTS
Before setting up the system get to know with the system requirements.

QUICK STEPS
1. After installing the software, open the reception tool from the Windows desktop.
2. Set up the network and the Cardio GX hardware with the reception tool. See more in System settings.
3. Set up the session types with the reception tool.
4. Create a training session and sign up the exercisers with the reception tool. Give the transmitters to the
exercisers during sign-up.
5. Start a heart rate-based group exercise session with the session tool in the group exercise room.
6. An individual session summary is displayed and sent to the class exercisers by email after the session.

MEDICAL PRODUCTS IN PROFESSIONAL USE
Professional use sets high standards for the manufacturer, distributor and user of a medical device. Polar
offers user instructions and training for professional users in order to ensure the safe use of Polar devices.

TRAINING ARTICLES
For more information on the physiological aspects and other features of Polar products, visit the Polar Collection of Training Articles.

BLUETOOTH
Polar Cardio GX uses Bluetooth wireless communication between the transmitters and the base station. Bluetooth provides the most reliable and secured technology for transmitting live data in the sports instrument
industry today.
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INTRODUCTION TO HARDWARE
The Polar Cardio GX system includes the following hardware:
l

Polar Team² Base Station Pro

l

Polar Team² Charger

l

Polar Team² Transmitters consisting of connectors and straps.

Before setting up the system get to know with the system requirements.
The light and sound indicators of the Polar Team² devices are presented in the Lights and sounds topic.

SYSTEM REQUIREMENTS
Depending on your Polar Cardio GX setup, the connectivity requirements differ. PC and AV requirements are
the same for all Cardio GX users.
In addition to the requirements listed below, it is recommended that you update system drivers regularly.

AV REQUIREMENTS
l

Video projector (minimum resolution: 1024 x 768)

l

Screen or suitable wall

PC REQUIREMENTS
Minimum PC requirements:

Recommended PC requirements

l

1.6 GHz processor

l

2 GHz processor

l

1 GB RAM

l

2 GB RAM

l

1 GB of free hard drive space

l

5 GB of free hard drive space

l

1024 x 768 monitor

l

Larger than 1024 x 768 monitor

l

Microsoft Windows XP, Vista or 7

l

Microsoft Windows XP, Vista or 7

l

Ethernet connection

OTHER REQUIREMENTS
Depending on your Cardio GX system setup, other requirements vary.
Requirements:
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l

l

a router when
l

there is more than one base station, or

l

there is more than one computer, or

l

the system is connected to the internet.

cross-over Ethernet cables (RJ45) to connect the computers and the base stations

POLAR TEAM² BASE STATION PRO
The base station is the device that connects the connectors with your PC. There can be up to three base stations in a Cardio GX system. The number of connectors online is determined based on the number of base stations:
l

one (main) base station: up to 28 connectors/exercisers online

l

two base stations (main + one secondary base station): up to 56 connectors/exercisers online

l

three base stations (main + two secondary base stations): up to 80 connectors/exercisers online

The main station does not differ from the secondary base stations on the hardware level. The first base station
you connect/introduce to the system becomes the main base station.

'
l

The base station is water-resistant. It can also be used outdoors and in the rain as long as the plug is in
place. Always use the wireless connection and battery power in the rain!
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l

An AC adapter is included in the Cardio GX set. There are four different plugs for the AC adapter.
Choose the correct plug and place it into the adapter.

l

The detachable legs must be used when the base station is placed on moist ground, e.g., on a wet
lawn, and during charging to prevent heating. The bottom of the base station may heat up to 60°C /
140°F

l

Operating temperature is -20°C - +60°C / -4°F - +140°F. During charging, the maximum operating temperature is 45°C / 113°F.

l

It is recommended that the base station is placed 2 m / 6.5 ft above the ground to optimize the signal.

l

When the base station is placed on the wall especially outdoors, the plug must be towards the ground.

l

A wall mounting kit is included in the Cardio GX set. The sockets that are provided in the wall mounting
kit are meant for concrete surfaces.

l

Check the range of the signal if the base station is surrounded by metal.

l

Built-in Wi-Fi (IEEE802.11b).

l

Built-in Bluetooth (100 m / 330 ft range)

l

RJ45 connector for Ethernet connection

l

Rechargeable batteries with up to 12 hours standalone use. Charging time 4 hours

FRONT PANEL

1. Charger and power indicators (see Lights and sounds)
2. Number indicators for connections and a Bluetooth logo (see Lights and sounds)
3. Power button
4. Ethernet port, power plug and reset button under the cover

POLAR TEAM² CHARGER
The charger is used to recharge the batteries of the connectors and to teach new connectors to the system.
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l

Up to ten connectors can be inserted into the
charger at the same time.

l

The connectors are inserted into the charger with
the led light left out. The led is located next to the
Polar Team² logo's letter R. Connectors are
inserted into the charger to recharge the batteries
and to teach new connectors to the system.

l

Polar Team² charger is only for indoor use (not
water-resistant).

l

An AC adapter is included in the Cardio GX set. There are four different plugs for the AC adapter.
Choose the correct plug and place it into the adapter.

l

A wall mounting kit is included in the Cardio GX set.

POLAR TEAM² TRANSMITTERS
The transmitter consists of a strap and a connector.The connector detects heart rate and transmits it to the
PC via the base station using Bluetooth. During training the heart rate data can also be monitored with a compatible Polar training computer.
The Polar Cardio GX set includes 10 transmitters. Additional transmitters can be bought as accessories.
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l

The connector is water-resistant but it is not suitable for swimming.

l

The connector is in the sleep mode if it is not inserted into charger or attached to the strap.

l

If the data transmission ceases during training, the connector searches for a new connection automatically.

l

The connectors are equipped with Polar magnetic communication technology. For example, the following Polar training computers can be used with the transmitter: FT1, FT2, FT4, FT7, FT40, FT60,
FT80, RS100, RS300X, RS400 and RCX5. A full list of compatible training computers can be found at
Polar website.

l

The Team² transmitter strap is designed exclusively for the Team² connector; other Polar straps are not
compatible with the Team² connector.

l

Rechargeable battery, up to 24 hours of stand alone use. Charging 24 hours.

l

Built-in Bluetooth (100 m / 330 ft range).

l

Transmitter strap and connector materials can be seen in Technical specifications.

l

The strap is machine washable.

See also Wearing the transmitter and Non-secured transmitter mode.

LIGHTS AND SOUNDS
The base station and connectors indicate their status with different lights and sounds.

BASE STATION
The lights are located in the front panel of the base station.
Light

Function
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Charge indicator

Green light is on: Power cable is connected and/or the battery is full.
Red light is on: Battery is low and charging.
Red light is blinking every 5 seconds: Battery is low and not charging.
Red light blinks for 3 seconds and power switches off automatically:
Battery is empty.

Power indicator

Base station is on.

Base station is ready for use. Takes approx. 1 minute to light up after switching the base station on.
On secondary base stations, the only one that lights up when the base station
is ready for use. Note that the main base station must also be on and ready for
use.
A PC is connected to the base station and the Cardio GX software is running.
Blinking

Base station is being added to the system. Wait until the light is continuously
lit.
At least one connector is connected to the base station with Bluetooth.
Lights up on main base station when at least one secondary base station is
connected to the main base station (automatically, wirelessly).

CONNECTOR
See the table below for description for lights and sounds during training.
Light/Sound

Function

Green led is blinking at
the same pace with
heart rate.

Connector detects the heart rate signal and is ready for transmitting.

Red led is blinking at
the same pace with
heart rate.

Connector detects the heart rate signal and is ready for transmitting. Memory
or battery level is low.

Start transmitting
sound, one beep.

Connector starts detecting and transmitting heart rate.
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Green led is blinking
every 3 seconds.

Connector is transmitting.

Stop transmitting
sound, two beeps.

Connector stops detecting and transmitting heart rate.

Red led is double blinking every 5 seconds for
30 seconds.

Transmitting cannot be started.

Stop recording sound.
Red led is double-blinking every 5 seconds for
10 minutes.

Transmitting has been stopped because the battery is empty.

Stop transmitting
sound.
See the table below for description for lights and sounds during charging/while the connectors are in the
charger.
Light/Sound

Function

Red led is on for 5 seconds.

Connector is properly placed into the charger.

Short sound.
Red led is blinking
every 5 seconds.

Connector is charging.

Green led is blinking
every 10 seconds.

Connector's battery is full.

Green led is on.

During teaching, the user can activate the connection between a new connector and the system by removing the connector from the charger.

Red led is on for 5 seconds.

Connector is properly placed into the charger, but is in non-secured mode.
l

If a connector has already been paired with a base station, it needs to
be in non-secured mode so that it can be introduced to another base station.

l

If a connector is introduced to the system, it cannot communicate with
the system in non-secured mode.

Three short sounds.

To change the mode to secured, remove the connector from the charger and
insert it back after a minimum of three seconds. Only one sound should be
heard.
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NON-SECURED CONNECTOR MODE
Connectors can be either in secured or non-secured mode. Basically these modes mean that:
l

in secured mode the connector is hidden from Bluetooth devices, preventing them from finding the connector, and

l

in non-secured mode the connector is visible for all Bluetooth devices.

How to recognize:
The connector is in secured mode if only one short sound is heard when it is inserted into the charger. The connector is in non-secured mode if three short sounds are heard when the connector is inserted into the charger.
See Lights and sounds.
How to change:
By default, when a connector is inserted into the charger it goes into secured mode. Change the connector's
mode to non-secured by removing the connector from the charger and inserting it back within 3 seconds while
the charger is plugged into a wall outlet. If you have several connectors that you want to put into non-secured
mode, the easiest way is to insert all the connectors into the charger and then unplug and replug the power
cord within 3 seconds.
Use:
Normally the connectors are always in secured mode. The non-secured mode is used only when:
l

the base station combination has been changed and the connectors must be synchronized with the
new combination, or

l

the connector has been previously paired with a base station and is now paired with another one.
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WEARING THE TRANSMITTER
In order for the transmitters to work properly (detect
and transmit heart rate data), follow the instructions
below.
1. Wet the electrode areas of the strap well under
running water.
2. Attach the connector to the strap. Adjust the
strap length to fit tightly but comfortably.
3. Tie the strap around your chest, just below the
chest muscles, and attach the hook to the other
end of the strap.
l

Note that if you are wearing a sports bra,
place the strap below the bra.

4. Check that the wet electrode areas are firmly
against your skin and that the Polar logo of the
connector is in a central and upright position.
l

When the transmitter starts detecting
and transmitting your heart rate, you can
hear a short beep and a green light starts
blinking on the connector. Now you can
also monitor your heart rate with a compatible Polar training computer.

After training, detach the connector from the strap
and follow the care and maintenance instructions.
A Team² connector can be used only with a Team² strap.

USING ONE COMPUTER IN CARDIO GX SYSTEM
SYSTEM REQUIREMENTS
Get to know with the system requirements in System requirements.

LOCAL AREA NETWORK
To connect your PC to the base station and to the internet, a local area network has to set up. Usually a local
area network is set up by using a router.
l

The router is connected to the internet.

l

The computer is connected to the router. The computer has access to the internet through the router.

l

The main base station is connected to the router with the network cable provided in the set.
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l

The optional secondary base stations are connected to the router with the network cable provided in
the set. Optionally the secondary base stations can be connected to the Cardio GX system wirelessly
through the main base station. The wireless connection is automatic after switching on the secondary
base stations.

SETTING UP THE CARDIO GX SYSTEM
1. Install both parts of the Cardio GX software onto the computer by using the Full option during the installation. Make sure the computer is connected to the router.
2. Set up the base stations (main and secondary) with the reception tool. See more details in Setting up
base stations.
3. Set up the connectors with the reception tool. See more details in Teaching connectors.
For more information, see System settings.
The Cardio GX system is ready to be used. Continue by creating the first training session.

USING TWO COMPUTERS IN CARDIO GX SYSTEM
SYSTEM REQUIREMENTS
Get to know with the system requirements in System requirements.
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LOCAL AREA NETWORK
To use the reception tool and the session tool on separate computers, a local area network has to be available
at your club. Usually a local area network is set up by using a router.
l

The router is connected to the internet.

l

The reception tool computer is connected to the router. The reception tool computer has access to
the internet through the router.

l

The main base station is connected to the router with the network cable provided in the set.

l

The session tool computer is connected to the router.

l

The optional secondary base stations are connected to the router with the network cable provided in
the set. Optionally the secondary base stations can be connected to the Cardio GX system wirelessly
through the main base station. The wireless connection is automatic after switching on the secondary
base stations.

SETTING UP THE CARDIO GX SYSTEM
1. Install the reception tool onto the reception tool computer. Make sure the reception tool computer is connected to the local area network.
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2. Set up the base stations (main and secondary) with the reception tool computer. See more details in
Setting up base stations.
3. Set up the connectors with the reception tool computer. See more details in Teaching connectors.
4. Install the session tool onto the session tool computer. Make sure the session tool computer is connected to the local area network.
For more information, see System settings.
The Cardio GX system is ready to be used. Continue by creating the first training session.
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RECEPTION TOOL
Cardio GX software consists of two parts. The reception tool is for managing sessions, session types and
exercisers, storing training data, setting up the hardware, and signing up for sessions. The reception tool is
used by the Cardio GX key users and club reception staff.
The other part of the software is the session tool which is for heart rate monitoring during the session and
summarizing the individual heart rate data after the session.

MENU
File
Change the language of the software by selecting File > Language. The available languages are English, German, French, Spanish, Italian and Portuguese. The new language is taken into use after restarting.
Set the email settings by selecting File > Email Settings. These must be set to send out individual training
reports to the exercisers after training sessions.
View a summary of the stored training data by selecting File > Data summary.
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Exit the reception tool by selecting File > Exit. Note that the reception tool stays running in the background.
Close the reception tool by right-clicking the Cardio GX icon in the taskbar and selecting Close reception
tool.
Help
Open the software help by selecting Help > Help Topics or by pressing F1 on the keyboard.
Open the Polar support pages by selecting Help > Product support.
Open the Polar website by selecting Help > Polar Website.
Check for the software updates regularly by selecting Help > Check for updates. We recommend that you
install all the software updates available to get the newest software features and user guidance.
Check the Polar Cardio GX software's version and other information by selecting Help > About.

TRAINING CALENDAR AND SIGN-UP
Access training calendar and sign-up in the reception tool by selecting Training Calendar. A training session
must be added to the training calendar before starting. Instructor and exercisers must also be signed up for the
session in this view. The system must be set up before arranging heart rate-based training sessions.
Each training session is created based on a session type. Adding a new session is quick and easy because
most of the session settings are already defined in the session type. The session types are defined in the
reception tool in the Session Types section. The number of session types in the Cardio GX system is not limited.
You can browse the training calendar in three different ways.
l

Shift between the weeks by using the arrow above the calendar.

l

Select another week by using the Calendar button.

l

Reset the view to the current week by clicking the Today button.

Add a new session by double-clicking the desired date and time. Added training sessions are displayed in the
training calendar. Open a future or held training session by double-clicking it.
See more details in:
l

Creating a training session

l

Signing up exercisers

l

Editing a training session

The date and time formats of the training calendar are set based on the Windows date and time settings.
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CREATING A TRAINING SESSION
1. Open the reception tool. Go to Training Calendar.
2. Double-click the desired date and time to add a training session.
3. Edit the session settings (name, date, start time, duration, repetition, session type and location).
4. Click Save to save the training session.
Plan the schedule ahead by defining repeating training sessions. Training sessions can be set to repeat
daily or weekly.
Return to the training calendar or sign up an instructor and exercisers. See more details about signing up in
Signing up exercisers.

SIGNING UP EXERCISERS
The instructor and exercisers must be signed up for the session when they arrive to the club. The exerciser
information is collected and the connectors are given to the exercisers during sign-up. Signing up is usually
done at the reception of your club.
In addition to the connector number, the following exerciser information is mandatory for sign-up: nickname,
year of birth and maximum heart rate. Additionally, the following exerciser information can be collected during
sign-up: sex, weight, height and email address. The nickname is shown on the screen during the session. The
email address is needed if the exerciser wishes to receive a training report after training session.
The maximum heart rate is calculated based on age (220 - age = maximum heart rate) but it can be edited if a
measured maximum heart rate for the exerciser is known. The calorie calculation is more accurate when the
maximum heart rate is set correctly. Height, weight and sex also affect the calorie calculation.
The instructor and exercisers are signed up in the same way. The instructor must be signed up before starting
the session but exercisers can be signed up even after the session has already started.
1. Open the reception tool. Go to Training Calendar.
2. Create a new training session or open an existing training session by double-clicking it in the calendar.
3. Pick up a connector.
4. Fill in the connector number into the first field.
5. Type the exerciser's nickname. If the software detects there are exercisers with similar nicknames
stored in the system, the software suggests them. Select a suggested exerciser or create a new one
by typing a unique nickname. When selecting an existing exerciser, the exerciser information is set
automatically. The exerciser information can be edited by using the edit button at the end of the row.
All exercisers in the Cardio GX system and in a session must have unique nicknames and email
addresses.
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6. When creating a new exerciser, type the exerciser's year of birth. The maximum heart rate is calculated automatically. Edit the maximum heart rate if a more accurate maximum heart rate is available.
7. Fill in the optional information.
8. Click Save to save the settings.
All exercisers who are signed up for a training session are automatically stored in exerciser management.
Their information can be updated in exerciser management and in the sign-up view. Exercisers can also be
manually added to the system in exerciser management. See more details in Exerciser management.
An individual training report cannot be sent to the exerciser if the email address field is not filled in during
sign-up.

EDITING A TRAINING SESSION
1. Open the reception tool. Go to Training Calendar.
2. Double-click an existing training session to edit it.
3. Edit the session settings (name, date, start time, duration, repetition, session type and location) or sign
up an instructor and exercisers. See more details about signing up in Signing up exercisers.
Exercisers can be signed up even after the session has already started.
4. Click Save to save the changes.
Note that training session cannot be edited after it has been held.

REMOVING EXERCISERS FROM SIGN-UP
1. Open the reception tool. Go to Training Calendar.
2. Open an existing training session by double-clicking it in the calendar.
3. Click the delete button (X) at the end of the row to remove the exerciser from the training session.
4. Click Save to save the settings.
Note that the exerciser is not removed from the system.

DELETING A TRAINING SESSION
1. Open the reception tool. Go to Training Calendar.
2. Click an existing training session with the secondary mouse button.
3. Select Delete session. The software asks for your confirmation.
A training session can also be deleted from the sign-up view by using the Delete session button.
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VIEWING SESSION SUMMARY
1. Open the reception tool. Go to Training Calendar.
2. Double-click a held training session to view the session summary.
3. Return to training calendar by clicking Close.
See also:
l

Opening exerciser's training report

l

Resending training reports

OPENING EXERCISER'S TRAINING REPORT
The same training reports that were sent by email after the training session can be accessed in the session
summary.
1. Open the reception tool. Go to Training Calendar.
2. Double-click a held training session to view the session summary.
3. Double-click exerciser's nickname in session summary to open the exerciser's individual training
report.
The training report (PDF) is opened. Save or print the training report if needed.

RESENDING TRAINING REPORTS
After a training session, the training reports are sent to the exercisers who have given their email addresses
during sign-up. If the Cardio GX software was unable to send the reports after a session, there is a message in
the session summary view.
To send the training reports again:
1. Open the reception tool. Go to Training Calendar.
2. Double-click a held training session to view the session summary.
3. Select exercisers by checking the boxes or click Select all below the list.
4. Click Send report to send the training reports to the selected exercisers.

SESSION TYPES
Access the session type settings in the reception tool by selecting Session types.
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Session types are templates for heart rate-based training sessions. Session types can include a different
number of zones, different combinations of motivational animations and different advertisements. Session
types speed up the creation of training sessions because most of the session settings are already defined in
the session type.
By default the Cardio GX software includes one session type (Polar Sport Zones). You cannot remove it or
edit its zones but you can add animations and advertisements to it. The number of session types in the Cardio
GX system is not limited.

ZONES
Zones are based either on maximum heart rate or anaerobic threshold. This is set by selecting one of the two
options (Maximum heart rate or Anaerobic threshold) while editing the session type.
When maximum heart rate is selected, the zones are based on the maximum heart rate. Maximum heart rate
is the highest number of heart beats per minute (bpm) during maximum physical exertion.A rough estimate of
maximum heart rate is 220 - the exerciser's age. Maximum heart rate is a useful tool for determining and comparing the intensity of training when the zones are based on % of maximum heart rate. If the maximum heart
rates are set correctly during sign-up, the exercisers will not exceed their maximum heart rates during the training session,
When anaerobic threshold is selected, the zones are based on anaerobic threshold. Anaerobic threshold is
the physiological point during training at which your muscles start using more oxygen than the body can transport. As a result, the work of the muscles starts producing more lactic acid than the body can process and it
starts to accumulate in the bloodstream. In order for the anaerobic threshold zones to work properly during a
training session, the exercisers must know their anaerobic thresholds and set them correctly during sign-up.
There are 3-5 zones in a session type. Zone names, zone limits and the number of zones can be edited in session type settings.

MOTIVATIONAL ANIMATIONS
Session types can include motivational animations. There are two types of motivational animations, Calorie
Bonus (burned calories during the session) and Zone Reward (exercisers in the same zone during the session). The animations are set on while editing the session type.
Calorie Bonus: the animation is shown during the session every time the exercisers burn 1000 kcal / cal in
total.
Zone Reward: the animation is shown during the session every time the exercisers spend at least 5 seconds
in the same zone.

ADVERTISEMENTS
Each session type can include advertisements that are displayed on the screen during the training session.
The number of advertisements is not limited. Advertisements can be added and removed in session type

27

settings.
Advertisement format:
l

Advertisements must be either in JPG, BMP or GIF format.

l

Although the software scales down the images to fit into the session tool, it is recommended to use low
and wide advertisements. For example, for 1024 x 768 displays/screens, a recommended advertisement size is 340 x 80 pixels.

l

The size of an advertisement is recommended to be less than 2 MB.

l

With pictures that have transparent background, the best visual outcome is achieved with GIF files.
See the example pictures below: on the left a JPG ad without transparent background and on the right a
JPG ad with transparent background.

For more information about transparency in picture files, contact your technical support or advertisement agency.

CREATING A SESSION TYPE
1. Open the reception tool. Go to Session Types.
2. Click Add.
3. Edit the session type settings (name, zones, animations and advertisements). See more details about
the settings in Session types.
4. Click Save to save the changes.
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EDITING A SESSION TYPE
1. Open the reception tool. Go to Session Types.
2. Select the session type from the list.
3. Edit the session type settings (zones, animations and advertisements). See more details about the settings in Session types.
4. Click Save to save the changes.

REMOVING A SESSION TYPE
1. Open the reception tool. Go to Session Types.
2. Select the session type from the list.
3. Click Remove. The software asks for your confirmation.

EXERCISER MANAGEMENT
Access exerciser management in the reception tool by selecting Exerciser management. Use the exerciser
management to manage the exerciser information stored in the Cardio GX system.
Stored exerciser information speeds up the sign-up because the exerciser information can be fetched from the
system database. The exercisers are identified by nickname or email address during sign-up.
All exercisers who are signed up for a training session are automatically stored in exerciser management. The
exerciser information can be updated in exerciser management. Exercisers can also be added manually to the
system in exerciser management.
The following exerciser information is stored in the system:
l

nickname,

l

first name and last name,

l

email address,

l

sex,

l

year of birth,

l

weight and height,

l

maximum heart rate and anaerobic threshold, and

l

the training sessions the exerciser has participated in.

Nickname, sex, year of birth and maximum heart rate are mandatory fields.
The stored training sessions for the selected exerciser are also shown in the profile.
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Sex, maximum heart rate or year of birth, weight and height are needed to calculate the burned calories during
a training session.
All exercisers in the Cardio GX system must have unique nicknames and email addresses.

ADDING AN EXERCISER
1. Open the reception tool. Go to Exerciser Management.
2. Click Add.
3. Fill in the exerciser information. See more details in Exerciser management.
4. Click Save to save the changes.
All exercisers in the Cardio GX system must have unique nicknames and email addresses.

EDITING AN EXERCISER
Editing an exerciser in Exerciser management:
1. Open the reception tool. Go to Exerciser Management.
2. Select the exerciser from the list.
3. Edit the exerciser information. See more details in Exerciser management.
4. Click Save to save the changes.
Editing an exerciser during sign-up:
1. Sign up exercisers as instructed in Signing up exercisers.
2. After signing up an existing exerciser (who has been previously stored in the system) or after saving
changes for new exerciser, click the edit button at the end of the row to edit the exerciser information.
3. Edit the exerciser information. See more details in Exerciser management.
4. Click Save to save the changed exerciser information. The exerciser information is updated to Exerciser Management.
5. Click Close to return to the sign-up view. The updated exerciser information is in the sign-up view.
All exercisers in the Cardio GX system must have unique nicknames and email addresses.

REMOVING AN EXERCISER
1. Open the reception tool. Go to Exerciser Management.
2. Select the exerciser from the list.
3. Click Remove. The software asks for your confirmation.
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SYSTEM SETTINGS
The system setup is always done with the reception tool. Access system settings in the reception tool by
selecting System Settings. Use the system settings to manage the base stations and connectors.
The hardware must be taken into use before arranging heart rate-based training sessions. An easy-to-understand wizard guides you through the setup process. Setting up the hardware must be done only once. See
more in Setting up base stations and Teaching connectors.
The Cardio GX system consists of 1-3 base stations and 1-2 computers. Reception tool and session tool
can be installed onto same or separate computers depending on your Cardio GX system setup.

BASE STATIONS
After the set-up wizard is completed, the base stations are displayed and managed on the left side of the system settings. The connection status is shown for all base stations.

CONNECTORS
After setting up wizard, the connectors are displayed and managed on the right side of the system settings.
The Cardio GX reception tool informs about problems with connectors in the connector box.
The following information is displayed for the connectors:
l

Connectors in the system: added connectors are listed in the connectors box.

l

Battery status: the green bar displays the battery status of a connector when the connector is in
charger and the computer is connected to the main base station.

l

Errors: take the mouse cursor on the marked connector to read the error message.

SETTING UP BASE STATIONS
Set up the base stations with the system settings wizard which starts automatically when accessing System
settings for the first time. An easy-to-understand wizard guides you through the setup process. After setting
up the base station, teach the connectors to the system.
The Cardio GX system consists of 1-3 base stations and 1-2 computers. Reception tool and session tool can
be installed onto same or separate computers depending on your Cardio GX system setup. The system setup
is always done with the reception tool.
If there is more than one base station or more than one computer in the Cardio GX system, a router is needed
to connect the pieces together. A router is also needed if the system is connected to the internet. See also
System requirements.
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BASIC SYSTEM SETUPS
The main base station is connected to the system with an Ethernet cable. The secondary base stations can
be connected to the system either wirelessly or with an Ethernet cable. The most typical system setups are
pictured below. The set up process is same for both cases, the only difference is how the hardware is connected at the gym. For more information, see Setting up system with multiple base stations.
Two or three base stations and two computers are connected with an Ethernet cable to the router. The router
is connected to the internet.

The main base station and two computers are connected with an Ethernet cable to the router. The secondary
base stations are connected wirelessly to the main base station. The router is connected to the internet.
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If there is only one base station in the system, the setup process is quicker. For more information, see Setting
up system with one base station.
REPLACING MAIN BASE STATION
Later on, if you need to replace the main base station, for example if the current main base station is broken,
see details and instructions in Replacing a main base station.
SETTING UP SYSTEM WITH ONE BASE STATION
Cardio GX system that includes one base station can include either one or two computers. The reception tool
and the session tool can be installed onto same or separate computers depending on your Cardio GX system
setup. The system setup is always done with the reception tool.
Requirements:
l

a router if there is two computers in use

l

a cross-over Ethernet cable (RJ45) to connect a base station to the computer/router during system
setup

After setup, a cross-over Ethernet cable (RJ45) is required to connect the base station to the computer/router.
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1. Open the reception tool. Go to System Settings. The system settings wizard starts automatically if
there are no base stations in the system.
2. Select the number of base stations you have. In this case, when you are setting up a system one base
station, select one.
You can add more secondary base stations later. Click Next to continue.
3. Set the wireless network settings. Type in a Name and a Wireless network key for the Cardio GX's
wireless network. Click Next to continue.
4. Follow the instructions in the wizard to add the base station to the system. The base station can be connected to the computer or to the router during setup. Note that if the base station is connected to the
router, also the computer must be connected to the router.
After setting up the base stations teach the connectors to the system.
If you have only one computer and one base station, they can be connected with an Ethernet cable. If you
have two computers or you need to connect to the internet, you need to connect the pieces through a router.
SETTING UP SYSTEM WITH MULTIPLE BASE STATIONS
Cardio GX system that includes multiple base stations typically includes two computers, and the reception
tool and the session tool are installed onto separate computers. It is also possible to have only one computer
that has a full installation of Cardio GX. The system setup is always done with the reception tool.
Requirements:
l

a router

l

a cross-over Ethernet cable (RJ45) to connect a base station to the computer/router during system
setup

After setup, if wireless connection is not used, additional cross-over Ethernet cables (RJ45) are required to
connect the secondary base stations to the router.
1. Open the reception tool. Go to System Settings. The system settings wizard starts automatically if
there are no base stations in the system.
2. Select the number of base stations you have. In this case, when you are setting up a system with multiple base stations, select either two or three.
You can add more secondary base stations later. Click Next to continue.
3. Set the wireless network settings. Type in a Name and a Wireless network key for the Cardio GX's
wireless network. Click Next to continue.
4. Follow the instructions in the wizard to add the main base station to the system.
5. Follow the instructions in the wizard to add the secondary base stations.
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The base stations can be connected to the computer or to the router during setup. Note that if the base station
is connected to the router, also the computer must be connected to the router.
After setting up the base stations teach the connectors to the system.
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Based on your needs, the secondary base stations can be connected to the system either wirelessly or with
an Ethernet cable. The main base station is always connected to the system with an Ethernet cable. The computer or computers are also connected to the system with an Ethernet cable.
SETTING UP SECONDARY BASE STATIONS
In order to use more than 28 connectors simultaneously, secondary base stations must be set up to the Cardio GX system. Additional base stations can be purchased as accessories. Follow the steps below if you did
not set up secondary base stations during the system settings wizard.
1. Open the reception tool. Go to System Settings.
2. Make sure the main base station is set up. The main base station should be available in System Settings. If you want to change the main base station's settings (name or wireless network key), do it
before setting up the secondary base stations.
3. Switch off the main base station and the possible secondary base station. Keep the reception tool
running and the System Settings section open.
4. Click Add secondary base station.
5. Connect a secondary base station to the computer or to the router with the cross-over Ethernet cable
provided in the set.
6. Switch on the secondary base station. Wait until the software detects the new base station. It may
take up to 1 minute.
7. Click OK to add the secondary base station to the Cardio GX system.
8. Switch off the secondary base station and unplug the Ethernet cable. If you want to set up another
secondary base station, repeat steps 3-7.
To utilize secondary base stations, the main base station must be on and connected to the computer or to the
router. Depending on your Cardio GX system setup, the secondary base stations connect to the Cardio GX
system either with an Ethernet cable through the router or wirelessly through the main base station.
If you are setting up additional base stations after already using the Cardio GX system, you have to synchronize the connectors with the new base station combination. See more details in Synchronizing connectors with new base stations.
If the base station has previously been used with any Team² or Cardio GX system (as a main or secondary base station), it must be reset before it can be set up to the system (as a main or secondary base station) again. See more details in Resetting base station.
REPLACING A MAIN BASE STATION
You can replace the main base station for example if the current main base station is broken. The current main
base station can be replaced with a secondary base station or a new base station.

36

1. Open the reception tool. Go to System Settings.
2. Click the arrow in the main base station's information box.
3. Click Remove. All base stations are removed from the system.
4. Reset the old base stations in the system. See more details in Resetting base station.
5. Set up the base stations normally. See more details in Setting up base stations.
6. After setting up the base stations, synchronize the connectors with the new base station combination. See more details in Synchronizing connectors with new base stations.
If the the main base station is replaced in the Cardio GX system, all the base stations in the system must
be set up again.

TEACHING CONNECTORS
Before you can use transmitters for online monitoring, the connectors must be introduced to the system. It
takes only a few minutes, and it has to be done only once for every connector. You can teach up to 80 connectors to the system.
1. Open the reception tool. Go to System Settings.
2. Make sure the base stations are set up. The base stations should be available in System Settings.
3. Connect the main base station to the PC or to the router with a network cable provided in the set.
4. Switch on the main base station. Wait until
approximately 1 minute.

and

are lit on the main base station. It takes

5. Plug the power cable into the charger and insert the (new) connectors into the charger.
6. Wait until

is lit on the main base station. New connectors appear into the New box.

7. Select a connector under New. Wait until the software assigns a number for the connector. It may take
up to 15 seconds.
8. Pick up corresponding number sticker and remove the connector with a continuously lit green light from
the charger.
9. Click OK and attach the sticker onto the connector. The connector moves into the connectors box.
10. Repeat steps 5/7 to 9 until you have taught all the connectors to the system.
If you re-insert the taught connectors into the charger, their battery status is shown in the connectors box.
See also Removing connectors from the system.

REMOVING CONNECTORS FROM THE SYSTEM
After removing a connector from the system, you can re-teach the connector at any time.
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1. Open the reception tool. Go to System Settings.
2. Find the connector you want to remove from the list and click it with the secondary mouse button.
3. Select Remove connector to remove the connector from the system. The software asks for your confirmation.
4. Repeat steps 2 and 3 for each connector you want to remove.

RESETTING BASE STATION
If the base station has previously been used with any Team² or Cardio GX system (as a main or secondary
base station), it must be reset before it can be set up to the system (as a main or secondary base station)
again.
1. Switch on the base station, do not connect it to the computer or the local area network. Make sure
the other base stations are switched off.
2. Wait until light

is lit on the base station.

3. Push the reset button on the base station front panel with a pen or pencil. The reset button is under
the plug.
4. Add the base station to the system as a main or secondary base station. See more details in Setting
up base stations.

SYNCHRONIZING CONNECTORS WITH NEW BASE STATIONS
After replacing the main base station or setting up a secondary base station (after already using the Cardio GX
system), you have to synchronize the connectors with the new base station combination. The Cardio GX
reception tool informs about problems with connectors in System Settings. Take the mouse cursor on the
marked connector to read the error message.
If you had connectors taught to the Cardio GX system before the base station combination changed, follow
the steps below:
1. Connect the main base station to the computer or to the router with the cross-over Ethernet cable provided in the set.
2. Switch on the main base station.
3. Open the reception tool. Go to System Settings. Wait until
tion. It takes approximately 1 minute.

and

are lit on the main base sta-

4. Plug the power cable into the charger.
5. Insert connectors into the charger in non-secured mode. For more information, see more details in
Non-secured connector mode.
6. As soon as connectors are synchronized with the new base station combination, the error noti-
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fications disappear from the synchronized connectors.
7. Repeat steps 4 to 6 until you have synchronized all the connectors.
If you teach the connectors to the system after you have set up all the base stations, synchronization is
not required.

SETTING EMAIL SETTINGS
To send individual training reports to the exercisers by email after a training session, the email settings have
to be set in the reception tool. The training reports are sent automatically to the exercisers who have given
their email addressed during sign-up.
1. Access the email settings by clicking File > Email settings.
2. Set the server and authentication settings.
3. Set the sender address and message subject in email settings.
4. Set the automated message text.
5. Save the settings by clicking OK.
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SESSION TOOL
Cardio GX software consists of two parts. The session tool is for heart rate monitoring during the training session and showing the individual heart rate summary after the session. The session tool is used by the group
exercise instructors.
The other part of the software is the reception tool which is for managing sessions, session types and exercisers, storing training data, setting up the hardware, and signing up for sessions.

The session tool opens into a full screen mode. You can close it by clicking the Exit button
. While
the session tool is running, you can access your Windows desktop by pressing the Windows key on your keyboard. If you have other applications running simultaneously, <Alt> + <Tab> key combination allows you to
toggle between open applications.

SCREEN SAVER
It is recommended that you turn off the screen saver or set the screen saver wait time to 90-120 minutes.
Windows XP:
1. Start > (Settings >) Control Panel > Display > the Screen Saver tab.
2. Turn off the screen saver by selecting None from the drop-down list or set the Wait time to 90-120 minutes.
Windows Vista and Windows 7:
1. Start > Control Panel > Personalization > Screen Saver.
2. Turn off the screen saver by selecting None from the drop-down list or set the Wait time to 90-120 minutes.

BEFORE TRAINING
Before arranging a heart rate-based training session:
l

the hardware must be taken into use, for more details see System settings.

l

the hardware must be set up in the gym so that the base stations and computers are all connected.

l

the session tool computer must be set up so that the contents of the display is projected on the screen
or on a suitable wall.

l

a training session must be created in the reception tool, for more details see Training calendar and signup.
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l

the instructor and the exercisers must be signed up for the session. They should wear the transmitters
when arriving to the training session.

STARTING A HEART RATE-BASED TRAINING SESSION
1. Make sure the reception tool is running (on the same computer or on the separate reception tool computer).
2. Make sure a training session has been created to the training calendar.
3. Open the session tool. Wait until the session tool finds the base stations and the reception tool computer. The connections are ready when the training session list is shown.
4. Make sure the correct training session is selected from the session list. Toggle between the available
training sessions with the arrows.
5. Click Select to confirm the selection of the training session.The heart rates of the instructor and the
exercisers appear on the screen.
6. Click the play button

when the session is ready to be started.

DURING TRAINING
During a training session, the heart rates of the instructor and the exercisers are displayed on the screen.
In addition to the exerciser nickname, the exerciser's heart rate is shown in beats per minute (bpm) and percentage of maximum heart rate.The corresponding zone is also shown. If the exerciser's height, weight and
sex were collected during sign-up, burned calories are also shown on the screen.

CONTROLS
l

Pause the session by clicking the pause button
sion, click the start button

l

. To continue the ses-

.

End the session by clicking the stop button

while the session is paused.

ZONES
During a training session the zones are displayed at the bottom of each exerciser's heart rate box with the colors selected in the session type settings in reception tool. The background color of the heart rate box changes
based on the exerciser's current heart rate and zone.
The instructor can guide the exercisers by using:
l

the zone number (e.g. "train in zone 3"),

l

the zone color (e.g. "train in green zone"), or
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l

the percentage of the heart rate maximum (e.g. "train at 60 - 65 % intensity").

MOTIVATIONAL ANIMATIONS
Depending on the session type settings, motivational animations can be shown on the screen during a training
session.
When Calorie Bonus is set on, an animation is shown every time the exercisers have burned 1000 calories
during the session as a group. The number of calories is the total for every exerciser in the session.
When Zone Rewardis set on, an animation is shown every time all the exercisers have spent at least 5 seconds in the same zone. The Zone Reward animation is not shown during the first 5 minutes of a training session, and not again for the same zone within 5 minutes.

AFTER TRAINING
After the instructor has ended the training session by clicking the stop button
(see During training),
the Polar Cardio GX software displays an individual session summary for each exerciser. The exerciser's
name, average and maximum heart rate and zone summary are displayed. For easy comparison, the durations spent in each zone are displayed in minutes and seconds and with colored bars. If the exerciser's height,
weight and sex were collected during sign-up the burned calories are also shown. The instructor can discuss
the results with the exercisers.
A training report with a session summary, a heart rate curve and feedback is sent to the the exercisers by
email if their email addresses were collected during sign-up.
The home button takes you back to the training session selection A new training session can be started.

Close the session tool by clicking the exit button

.

The exercisers should follow the care and maintenance instructions of the transmitter straps and connectors,
and return the connectors to the reception.
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TROUBLESHOOTING
Troubleshooting offers you firsthand help when you have a problem either with the hardware or the PC software.
The search engine in the help is helpful in many situations. The search engine can be found in the upper right
corner.

SEARCH TIPS
l

Use simple search words or sentences. Two or three words are enough.

l

Use basic forms of verbs.

l

The search engine does not understand the meaning of interrogatives like "why", "what" and "when".
Instead use keywords, such as "transmitter", "green light" and "managing", as search words.

TRAINING ARTICLES
For more information on the physiological aspects and other features of Polar products, visit the Polar Collection of Training Articles.

ONLINE TRAINING
Below you can find help to some common problems with online training.
Problem

Cause

Transmitter/Exerciser's Connector's battery is
information disempty.
appears from the grid.
Strap's electrode
areas are dry or strap
is secured incorrectly.

Solution
Recharge connector's battery.

Wet the electrode areas of the strap under running
water. Make sure that the strap is secured correctly
and the wet electrode areas are firmly against exerciser's skin.

Connection between
the PC and the base
station is momentarily
disconnected.

Wait for a moment. If connection is not restored,
switch the base station off and on again. Also re-open
the software and establish connection between PC
and base station normally.

Base station's battery
is empty.

Plug the power cable into the base station and into the
wall outlet.

The transmitter is out
of the base station's
range.

Wait until the exerciser is again in the base station's
range. Make sure nothing is interfering the connection
from the transmitter to the base station.
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Transmitter/Exerciser
is not shown during
online training.

Connector's battery is
empty.

Recharge connector's battery.

Strap's electrode
areas are dry or strap
is secured incorrectly.

Wet the electrode areas of the strap under running
water. Make sure that the strap is secured correctly
and the wet electrode areas are firmly against exerciser's skin.

Connection between
the PC and the base
station is not established correctly.

Make sure the connection between the base station
and the PC is established correctly.

Base station's battery
is empty.

Plug the power cable into the base station and into
wall outlet.

There exerciser is not
signed up for the session.

The exerciser should sign up for the session.

Connector is in nonsecured mode.

Change the connector's mode to secured by removing
the connector from charger and inserting it back after a
minimum of 3 seconds. Only one sound should be
heard.

TRAINING COMPUTER
Below you can find help to some common problems with training computer usage with the Cardio GX system.
Problem

Cause

Solution

The heart rate
is not displayed on the
training computer display.

Your Polar training
computer is not
compatible with the
Polar Team² transmitters.

For example, the following Polar training computers are compatible with the Polar Team2 transmitters: FT1, FT2, FT4, FT7,
FT40, FT60, FT80, RS100, RS300X, RS400 and RCX5. Full list
of compatible training computers can be found at Polar website.

Your Polar training
computer is not in
training mode.

Set your training computer in training mode. Usually, it is done by
pressing the Red or OK button twice. For more information, see
the user manual of your Polar product.

TRANSMITTERS
Below you can find help to some common problems with transmitters with the Cardio GX system.
Problem

Cause

Solution

The connector cannot

The con-

Change the connector's mode to non-secured by removing the
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be taught to the system
via reception tool.

nector is in
secured
mode,
because it
has already
been paired
with another
base station.

connector from the charger and inserting it back within 3 seconds. When inserted into the charger, three short sounds are
heard instead of one. Note that after you have taught the connector to the system, the connector's mode is automatically
changed to secured.

When inserted into
charger, there is no
sound or light.

Power cable
is not plugged
into the
charger.

Plug the power cable into charger and into the wall outlet.

Connector is
inserted into
charger incorrectly.

Insert connector into the charger so that the P of Polar logo is
not visible. The led is located next to the R of Polar logo.

Connectors are not
shown as connected
even if they are inserted
into the charger correctly and there is a connection between the
base station and the
PC.

Power cable
is not plugged
into the
charger.

Plug the power cable into charger and into the wall outlet.

The connectors are in
non-secured
mode.

Change the connector's mode to secured by removing the connector from charger and inserting it back after a minimum of 3
seconds. Only one sound should be heard.

New connector does
not appear to the connector list in the reception tool.

Connector is
inserted into
charger incorrectly.

Insert connector into the charger so that the P of Polar logo is
not visible. The led is located next to the R of Polar logo.

There is no
connection
between the
base station
and the PC.

For more information, see System settings.

Contact problem between
the connector
and the
charger.

Remove the connectors that were not found from the charger
and insert them back. You can also try to insert the connector
into another slot of the charger.

The number label has
come off and you do
not know which connector it is.

If only one connector does not have a label, check the rest of
the connectors' labels. The number that is missing is the connector's number.
If there are two or more connectors without a label, insert the
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connectors one by one into the charger (one at a time). Open
the reception tool and establish connection between the base
station and the PC. Wait until the connector is connected to
the system. Find out which connector is marked as connected
in the connector list. Repeat this until you know the numbers
of each connector.
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CUSTOMER SERVICE INFORMATION
l

Care and maintenance instructions

l

Precautions

l

Important safety information

l

Regulatory information

l

Radio frequency technical specification

l

Guarantee and disclaimer

SERVICE
Your Polar Cardio GX system is designed to help you achieve your personal fitness goals and indicate the
level of physiological strain and intensity during training sessions. No other use is intended or implied.
During the one-year guarantee/warranty period we recommend that you have service done by an
authorized Polar Service Center only. The warranty does not cover damage or consequential damage
caused by service not authorized by Polar Electro.

CARE AND MAINTENANCE INSTRUCTIONS
It is important to follow the care and maintenance instructions to assure the long life of the Cardio GX hardware. Sweat and moisture can keep the electrodes wet and the transmitter activated, which shortens
battery life.

TRANSMITTER STRAPS

l

After training, detach the connector from the strap.

l

Rinse the straps under running lukewarm water after every use.

l

Wash the straps in a washing machine at 40 °C / 104°F after every fifth use. Always use the washing
pouch (included in the Cardio GX set). NOTE: Detach the connectors from the straps before washing!

l

Do not use bleach or fabric softener.

l

Make sure straps are dry before storing.

CONNECTORS
l

Detach the connector from the strap and store separately.

l

Rinse the connectors under running lukewarm water after every use.

47

l

Do not insert wet connectors into the charger.

l

You may store the connectors in the charger, but make sure the charger's power cable is not plugged in
during storage.

l

When the transmitters are not in daily use or are stored for a longer period of time, recharge the connectors regularly to prevent a complete exhaustion of the batteries inside the connectors.

CHARGER AND BASE STATION
l

Wipe the base station and the charger regularly with a moist cloth.

PRECAUTIONS
MINIMIZING POSSIBLE RISKS
Training may include some risk. Before beginning a regular training program, answer the following questions
concerning your health status. If you answer yes to any of these questions, consult a physician before starting
any training program.
l

Have you been physically inactive for the past 5 years?

l

Do you have high blood pressure or high blood cholesterol?

l

Do you have symptoms of any disease?

l

Are you taking any blood pressure or heart medication?

l

Do you have a history of breathing problems?

l

Are you recovering from a serious illness or medical treatment?

l

Do you use a pacemaker or other implanted electronic device?

l

Do you smoke?

l

Are you pregnant?

Note that in addition to training intensity, medications for heart conditions, blood pressure, psychological conditions, asthma, breathing, etc., as well as some energy drinks, alcohol, and nicotine may also affect heart
rate. It is important to be sensitive to your body’s responses during training. If you feel unexpected pain or
excessive fatigue when training, stop the exercise or continue at a lighter intensity.
If you have a pacemaker, defibrillator or other implanted electronic device, you use the Polar Cardio GX system at your own risk. Before starting use, take a maximal training stress test under the supervision of a physician. The test is to ensure the safety and reliability of the simultaneous use of the pacemaker and the Polar
Cardio GX system. If you are allergic to any substance that comes into contact with your skin or if you suspect an allergic reaction due to using the product, check the listed materials in Technical Specifications. To
avoid any skin reaction to the transmitter, wear it over a shirt. Moisten the shirt well under the electrodes to
ensure flawless operation. If you use insect repellent on your skin, make sure that it does not come into contact with the transmitter.
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Exercise equipment with electronic components may cause interfering stray signals. To tackle these
problems, try the following:
1. Remove the transmitter from your chest and use the exercise equipment as you would normally.
2. Move the wrist unit around until you find an area in which it displays no stray reading or does not flash
the heart symbol. Interference is often worst right in front of the display panel of the equipment, while
the left or right side of the display is relatively free of disturbance.
3. Put the transmitter back on your chest and keep the wrist unit in this interference-free area as much as
possible.
If the Polar Cardio GX system still does not work, the piece of equipment may be electrically too noisy for wireless heart rate measurement.
Polar Cardio GX transmitter may not be worn when swimming. For more information, visit https://
support.polar.com. Water resistance of Polar products is tested according to International Standard ISO
2281. Products are divided into three categories according to their water resistance. Check the back of your
Polar product for the water resistance category, and compare it to the chart below. Please note that these
def-initions do not necessarily apply to products of other manufacturers.

Marking on case back

Water resistant characteristics

Water resistant

Protected against wash splashes, sweat, raindrops etc. Not suitable for swimming.

Water resistant 30 m/50 m

Suitable for bathing and swimming

Water resistant 100 m

Suitable for swimming and snorkeling (without air
tanks)

IMPORTANT SAFETY INFORMATION
BASE STATION
l

The detachable legs must be used when base station is placed on moist ground, e.g., on a wet lawn.

l

During charging the legs of the base station must be used because the bottom of the base station
heats up to 60°C (140°F). During charging, the maximum operating temperature is 45°C (113°F).

AC-POWERED DEVICES
These precautions apply to all products that plug into a standard wall power outlet.
Failure to take the following precautions can result in serious injury or death from electronic shock or fire or in
damage to the device.
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TO SELECT AN APPROPRIATE POWER SOURCE FOR YOUR DEVICE:
l

Use only the power supply unit and AC power cord that came with your device or that your received
from an authorized repair center.

l

AC adapters are only for indoor use.

l

Confirm that your electrical outlet provides the type of power indicated on the power supply unit (in
terms of voltage [V] and frequency [Hz]). If you are not sure of the type of power supplied to your home,
consult a qualified electrician.

l

Do not use non-standard power sources, such as generators or inverters,even if the voltage and
frequency appear acceptable. Use only AC power provided by a standard wall outlet.

l

Do not overload your wall outlet, extension cord, power strip, or other electrical receptacle. Confirm
that they are rated to handle the total current (in amps [A]) drawn by the device (indicated on the power
supply unit) and any other devices that are on the same circuit.

TO AVOID DAMAGING THE POWER CORDS AND POWER SUPPLY:
l

Protect the power cords from being walked on.

l

Protect cords from being pinched or sharply bent, particularly where they connect to the power outlet,
the power supply unit, and the device.

l

Do not jerk, knot, sharply bend, or otherwise abuse the power cords.

l

Do not expose the power cords to sources of heat.

l

Keep children and pets away from the power cords. Do not allow them to bite or chew on them.

l

When disconnecting the power cords, pull on the plug - do not pull on the cord.

If a power cord or power supply becomes damaged in any way, stop using it immediately. Unplug your device
during lightning stroms or when unused for long periods of time.
For devices with an AC power cord that connects to the power supply, always connect the power cord according to the following instructions:
1. Plug the AC power cord into the power supply unit until it stops.
2. Plug the other end of the AC power cord into the wall outlet.

BATTERY-POWERED DEVICES
These precautions apply to all products that use rechargeable or disposable batteries.
Improper use of batteries may result in battery fluid leakage, overheating, or explosion. Released battery fluid
is corrosive and may be toxic. It can cause skin and eye burns, and is harmful if swallowed.
RECHARGEABLE BATTERIES ONLY:
l

Charge only with the recharger provided with the product.
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WIRELESS DEVICES
Such as base station and transmitter.
Before boarding any aircraft or packing a wireless device in luggage that will be checked, remove the batteries
from the wireless device or turn the wireless device off (if it has an on/off switch). Wireless devices can transmit radio frequency (RF) energy, much like a cellular telephone, whenever batteries are installed and the wireless device is turned on (if it has an on/off switch).

ALL DEVICES
DO NOT ATTEMPT REPAIRS
Do not attempt to take apart, open, service, or modify the hardware device or power supply. Doing so could
present the risk of electrical shock or another hazard. Any evidence of any attempt to open and/or modify the
device, including any peeling, puncturing, or removal of any of the labels, will void the Limited Warranty.
CHOKING HAZARD
This device may contain small parts that which may be a choking hazard to children under 3. Keep small parts
away from children.

REGULATORY INFORMATION
l

Base Station

l

Transmitter

l

Charger

BASE STATION
FCC REGULATORY INFORMATION
This device complies with part 15 & 18 of the FCC rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) This device must accept any interference
received, including interference that may cause undesired operation.
Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules and for a miscellaneous type ISM device, pursuant to part 18 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:
1) Reorient or relocate the receiving antenna.
2) Increase the separation between the equipment and receiver.
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3) Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4) Consult the dealer or an experienced radio/TV technician for help.
Caution! Changes or modifications not expressly approved by the party responsible for compliance could
void the user's authority to operate the equipment.
FCC RADIATION EXPOSURE STATEMENT
The radiated output power of the Base Station is far below the FCC radio frequency exposure limits. Nevertheless, the Base Station should be used in such a manner that the potential for human contact during normal operation is minimized. To avoid the possibility of exceeding the FCC radio frequency exposure limits,
you should keep a distance of at least 20 cm between you and the Base Station.
INDUSTRY CANADA (IC) REGULATORY INFORMATION
This device complies with RSS-210 and ICES-001of Industry Canada rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) This device must accept
any interference received, including interference that may cause undesired operation.
INDUSTRY CANADA (IC) RADIATION EXPOSURE STATEMENT
The radiated output power of the Base Station is far below the Industry Canada radio frequency exposure limits. Nevertheless, the Base Station should be used in such a manner that the potential for human contact during normal operation is minimized. To avoid the possibility of exceeding the Industry Canada radio frequency
exposure limits, you should keep a distance of at least 20 cm between you and the Base Station.
EUROPE

This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of
Conformity is available at support.polar.com.
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Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the European Parliament and of the Council on waste electrical and electronic equipment (WEEE). These products should thus
be disposed of separately in EU countries. Polar encourages you to minimize possible effects of waste on the
environment and human health also outside the European Union by following local waste disposal regulations
and, where possible, utilize separate collection of electronic devices.
SOUTH AFRICA

SINGAPORE

TRANSMITTER
FCC REGULATORY INFORMATION
This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) This device must accept any interference received,
including interference that may cause undesired operation.
Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:
1) Reorient or relocate the receiving antenna.
2) Increase the separation between the equipment and receiver.
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3) Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
4) Consult the dealer or an experienced radio/TV technician for help.
Caution! Changes or modifications not expressly approved by the party responsible for compliance could
void the user's authority to operate the equipment.

INDUSTRY CANADA (IC) REGULATORY INFORMATION
This device complies with RSS-210 of Industry Canada rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) This device must accept any interference
received, including interference that may cause undesired operation.
EUROPE

This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of Conformity
is available at www.polar.fi/support.

This marking shows that the product is protected against electric shocks.

Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the European Parliament and of the Council on waste electrical and electronic equipment (WEEE). These products should thus
be disposed of separately in EU countries. Polar encourages you to minimize possible effects of waste on the
environment and human health also outside the European Union by following local waste disposal regulations
and, where possible, utilize separate collection of electronic devices.
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SOUTH AFRICA

SINGAPORE

CHARGER
FCC REGULATORY INFORMATION
This device complies with part 18 of the FCC rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) This device must accept any interference received,
including interference that may cause undesired operation.
Note: This equipment has been tested and found to comply with the limits for a miscellaneous type ISM
device, pursuant to part 18 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one
or more of the following measures:
1) Reorient or relocate the receiving antenna.
2) Increase the separation between the equipment and receiver.
3) Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.
4) Consult the dealer or an experienced radio/TV technician for help.
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Caution! Changes or modifications not expressly approved by the party responsible for compliance could
void the user's authority to operate the equipment.
INDUSTRY CANADA (IC) REGULATORY INFORMATION
This ISM device complies with ICES-001of Industry Canada rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) This device must accept any interference received, including interference that may cause undesired operation.
EUROPE

This product is compliant with Directives 93/42/EEC and 1999/5/EC. The relevant Declaration of Conformity
is available at www.polar.fi/support.

Polar products are electronic devices and are within the scope of Directive 2002/96/EC of the European Parliament and of the Council on waste electrical and electronic equipment (WEEE). These products should thus
be disposed of separately in EU countries. Polar encourages you to minimize possible effects of waste on the
environment and human health also outside the European Union by following local waste disposal regulations
and, where possible, utilize separate collection of electronic devices.
SOUTH AFRICA
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SINGAPORE

TECHNICAL SPECIFICATIONS
TRANSMITTER
Transmitter strap material:
l

35 % Polyester, 35 % Polyamide, 30 % Polyurethane.

Connector material:
l

Back cover: PA+GF,

l

Press-buttons: stainless steel AISI316,

l

Front cover: ABS + GF,

l

Lense on the front cover: PMMA

RADIO FREQUENCY TECHNICAL SPECIFICATIONS
CHARGER UNIT
Frequency: 13.56 MHz, Industrial-Scientific-Medical (ISM) band used.
BLUETOOTH DEVICES
Base station
RF output power: meets Bluetooth® requirements.
Frequency: 2400 MHz to 2483.5 MHz, max. 100 mW.
Bluetooth QD ID B011340.
Connector
RF output power: meets Bluetooth® requirements.
Frequency: 2400 MHz to 2483.5 MHz, max. 20 mW.
Bluetooth QD ID B011340.
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2.4 GHZ DEVICES (SUCH AS BASE STATION AND TRANSMITTER)
Non-specific short range device.
RF output power: meets all SRD requirements.
Frequency: within the range of 2400 MHz to 2483.5 MHz.
For Bluetooth and 2.4 GHz devices only: to comply with FCC RF exposure requirements, the following
operating configurations must be satisfied: the antenna has been installed by the manufacturer and no
changes can be made.

GUARANTEE AND DISCLAIMER
POLAR CARDIO GX INTERNATIONAL WARRANTY
l

Polar Electro Oy guarantees to the original purchaser of Polar Cardio GX that the product will be free
from defects in material or workmanship for ONE year from the date of purchase.

l

The original receipt is your proof of purchase!

l

Warranty does not cover damage due to misuse, abuse, accidents or negligence of the precautions;
improper maintenance, cracked or broken cases or the elastic strap. During the guarantee period the
product will be either repaired or replaced free of charge at an authorized Polar Service Center.

l

Polar Electro Oy’s warranty is limited to defects in material and workmanship. Polar Electro Oy’s liability is limited to repair or replacement of defective products. Polar Electro Oy shall not be liable for
any damages, losses, costs, or expenses, whether direct, indirect, incidental, consequential, or special, arising out of, or related to the use of Polar products.

© 2012 Polar Electro Oy, FIN-90440 KEMPELE, Finland.
Polar Electro Oy, FIN-90440 KEMPELE, Finland. Polar Electro Oy is a ISO 9001:2000 certified company. All
rights reserved. No part of this manual may be used or reproduced in any form or by any means without prior
written permission of Polar Electro Oy. The names and logos marked with a ™ symbol in this user manual or
in the package of this product are trademarks of Polar Electro Oy. The names and logos marked with a ® symbol in this user manual or in the package of this product are registered trademarks of Polar Electro Oy, except
that Windows is a trademark of Microsoft Corporation.

DISCLAIMER
l

The material in this manual is for informational purposes only. The products it describes are subject to
change without prior notice, due to the manufacturer’s continuous development program.

l

Polar Electro Inc. / Polar Electro Oy makes no representations or warranties with respect to this manual or with respect to the products described herein.

l

Polar Electro Inc. / Polar Electro Oy shall not be liable for any damages, losses, costs or expenses,
direct, indirect or incidental, consequential or special, arising out of, or related to the use of this material
or the products described herein. This product is protected by the incorporeal rights of Polar Electro Oy
as defined by the following documents: FI 20075426, US 21/133888, EP 08157710.8, FI115084,
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US7418237, EP1543769, FI110915, US7324841, US7018339, FI114202, US6537227, EP1147790,
HK1040065, FI96380, JP3568954, US5611346, EP665947, FI23471, EU00046107-0001,
USD492783S, USD492784S, USD492999S. Other patents pending.
Manufactured by Polar Electro Oy, Professorintie 5, FI-90440 KEMPELE, support.polar.com
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